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Matching (5) Chapter two
If the value in cell B2 is 30, the value in cell B3 is 4, the value in cell C2 is 10, the value in cell C3 is 8, and the value in cell D2 is 2, match each formula on the left with its numerical equivalent on the right.

	__
1.
=B2 + B3 * C3 - C2 / D2

__
2.
=C2 ^ 2 – B2 / D2 – B3 * C3

__
3.
=D2 * C3 + B3 * B2 / C2

__
4.
=B2 – B3 ^ 2 / C3 + C2 * D2

__
5.
=C3 * C2 – B3 ^ D2 - B2
	a. 53

b. 48

c. 28

d. 34

e. 57

f. 62

g. 54


Matching (5) chapter three
Each formula on the left is copied from cell B5 to cell C6. Match each formula on the left with the formula from the right that would be entered in cell C6.

	__
6.
=B3 + B4

__
7.
=$B$3 + $B$4

__
8.
=$C$4+$C$5

__
9.
=$B3 + B4

__
10.
=B3 + B$4
	
a.
=$B4 + C5


b.
=C4 + C$4


c.
=$B$3 + $B$4


d.
=C4 + C5


e.
=$C$4 + $C$5


f.
=B$3 + C4


g.
=$B$3 + B4


True/False (10) chapter three
Circle T if the statement is true and F if the statement is false.

T
F
11.
You can use the fill handle to create a series of numbers, dates, or month names.

T
F
12.
When you are copying the Clipboard contents to more than one nonadjacent cell or range, complete the copy by pressing the enter key.

T
F
13.
The Delete command clears the data from cells, but the cells remain in the worksheet.

T
F
14.
If formulas reference cells in a deleted row or column, Excel adjusts these cell references.

T
F
15.
If you assign the General format (Excel’s default format for numbers) to the date, the date displays as a number.

T
F
16.
The general form of the IF function is: =IF(logical_test, value_if_false, value_if_true).

T
F
17.
You move a toolbar by pointing to a button (not to the title bar or to a blank area within the toolbar window) and then dragging the toolbar to its new location.

T
F
18.
Excel normally displays a chart at approximately 50% magnification so that the entire chart displays on the screen.

T
F
19.
Window panes split by the vertical split bar scroll together vertically.

T
F
20.
Goal seeking assumes you can change the value of multiple cells referenced either directly or indirectly.

Multiple Choice (5) Chapter two
Circle the letter of the best answer.

21.
Which of the following formulas would have the same numerical value as =C2 + D2 * E2 – F2?

a. =(C2 + D2) * E2 – F2

b. =C2 + D2 * (E2 – F2)

c. =C2 + (D2 * E2) – F2

d. =(C2 + D2) * (E2 – F2)

22.
When determining the highest value in a range, what advantage does entering the MAX function have over simply scanning the range and entering the largest value as a constant?

a. Excel recalculates the highest value each time you enter a new value in the range

b. it usually is easier to enter a function than it is to enter a number accurately

c. Excel does not change the result of a function, even if other values in a worksheet are altered

d. functions can be entered using Point mode, but numbers only can be entered using the keyboard

23.
Before adding a percent sign, how is the value displayed in a cell determined when the Percent Style button on the Formatting toolbar is clicked?

a. by adding 100 to the cell entry and rounding the result to the nearest percent

b. by subtracting 100 from the cell entry and rounding the result to the nearest percent

c. by multiplying the cell entry by 100 and rounding the result to the nearest percent

d. by dividing the cell entry by 100 and rounding the result to the nearest percent

24.
How is saving the workbook a second time by clicking the Save button on the Standard toolbar different from saving the workbook again by clicking Save As on the File menu?

a. clicking the Save button automatically saves the workbook with the same file name

b. clicking Save As automatically saves the workbook with the same file name

c. clicking the Save button displays a dialog box that lets you save the workbook using a new name or to a different drive

d. clicking Save As displays a dialog box that lets you save the workbook using a new name or to a different drive

25.
To e-mail a workbook from within Excel, you must have an e-mail address and what for your e-mail program?

a. Outlook

b. Outlook Express

c. Microsoft Exchange Client

d. any of the above

Multiple Choice (5) chapter three
Circle the letter of the best answer.

26.
If $1234.5 is typed in the formula bar, what displays in the cell?

a. $1234.5

b. $1,234.5

c. $1234.50

d. $1,234.50

27.
What function is used to enter the system date in a worksheet cell?

a. DATE

b. DAYS360

c. NOW

d. TIME

28.
Cell B4 contains the value 100, and cell D5 contains the value 90. When the function =IF(B4 <> D5, 80, 70) is entered in cell E7, what value will display in cell E7?

a. 100

b. 90

c. 80

d. 70

29.
In which of the following would both the column and row references remain the same when you copy the cell reference?

a. B16

b. $B16

c. B$16

d. $B$16

30.
What happens when you Zoom (magnify) a worksheet?

a. the characters on the screen become small and fewer columns and rows display

b. the characters on the screen become large and fewer columns and rows display

c. the characters on the screen become small and more columns and rows display

d. the characters on the screen become large and more columns and rows display

Chapter 5

Multiple Choice

1. If a mistake is made when entering data into a data form, use the mouse or the __________ keys to move the insertion point to the previous text box to edit the entry.

a. alt+tab
b. shift+tab
c. ctrl+tab
d. insert+tab
2. To move from field to field in a data form, use the tab key or hold down the __________ key and press the key that corresponds to the underlined letter in the name of the desired field.

a. alt
b. shift
c. ctrl
d. insert
3. The general form of the VLOOKUP function is: __________.

a. =VLOOKUP(search argument, column number, table range)

b. =VLOOKUP(column number, search argument, table range)

c. =VLOOKUP(table range, column number, search argument)

d. =VLOOKUP(search argument, table range, column number)

4. The VLOOKUP function searches the leftmost column of a table, called the __________, which in the accompanying figure are the percents in the Grade Table.

a. table arguments

b. search arguments

c. table values

d. search values

5. The VLOOKUP function uses the __________, which in the accompanying figure is the % of Quota value in the record of a distributor, to search the leftmost column of the table for a particular value.

a. table argument

b. search argument

c. table value

d. search value

6. After searching the leftmost column of a table, the VLOOKUP function returns the corresponding value from the specified column, called the __________, which in the accompanying figure are the grades in the rightmost column.

a. table arguments

b. search arguments

c. table values

d. search values

7. It is most important that __________ are used for the table range in the VLOOKUP function, or Excel will adjust the cell references when the function is copied down through a column.

a. relative cell references

b. mixed cell references, row varying

c. mixed cell references, column varying

d. absolute cell references

8. All of the following are guidelines to follow when creating a database except __________.

a. maintain at least one blank row between a database and other worksheet entries

b. define the name, Database, as the database range

c. place column titles (field names) in the first row of the database

d. use blank rows to separate the column titles (field names) from the data

9. At any time while the worksheet is active, the __________ on the Data menu can be used to display records, add new records, delete records, and change the data in records.

a. Sort command

b. Filter command

c. Form command

d. Subtotal command

10. Each time the __________ in a data form is clicked, Excel advances to the subsequent record in the database.

a. Find Next button

b. New button

c. Find Prev button

d. Delete button

11. When using a data form, use the __________ to confirm or enter field changes.

a. down arrow key or the enter key

b. left arrow key or the backspace key

c. up arrow key or the shift key

d. right arrow key or the tab key

12. To add a record, click the __________ in the data form.

a. Find Next button

b. New button

c. Find Prev button

d. Delete button

13. Excel allows a database to be sorted on a maximum of __________ field(s) in a single sort operation.

a. one

b. two

c. three

d. four

14. When a database is sorted by quota within education within level, then __________.

a. level is the major sort key (Sort by field), education is the intermediate sort key (first Then by field), and quota is the minor sort key (second Then by field)

b. education is the major sort key (Sort by field), quota is the intermediate sort key (first Then by field), and level is the minor sort key (second Then by field)

c. quota is the major sort key (Sort by field), level is the intermediate sort key (first Then by field), and education is the minor sort key (second Then by field)

d. quota is the major sort key (Sort by field), education is the intermediate sort key (first Then by field), and level is the minor sort key (second Then by field)

15. If a mistake is made in a sort operation, the records can be returned to their original order by immediately clicking the __________ button on the Standard toolbar.

a. Sort Ascending

b. Redo

c. Sort Descending

d. Undo

16. To sort on four fields, sort on the three __________.

a. least important keys first and then sort on the minor key

b. most important keys first and then sort on the minor key

c. least important keys first and then sort on the major key

d. most important keys first and then sort on the major key

17. Comparison criteria are __________.

a. one or more conditions that include the field names and entries in the corresponding boxes in a data form

b. the field or fields selected on which to sort records

c. a row of column titles at the top of a worksheet database that can be used to identify each field on a data form

d. the field on which a database is sorted prior to invoking the Subtotals command

18. Displaying records that pass a test is called __________ the database.

a. sorting

b. querying

c. creating

d. redefining

Chapter 4
Multiple Choice

1. The Data Table section on the lower left in the accompanying figure __________.

a. provides general, basic information about the rudimentary loan requirements

b. answers questions pertaining to the effect of 11 different interest rates

c. links (file path names or URLs) to other Office documents or HTML files

d. shows the beginning and ending balances and the amount of payment

2. In the accompanying figure, the amortization schedule __________.

a. provides general, basic information about the rudimentary loan requirements

b. answers questions pertaining to the effect of 11 different interest rates

c. links (file path names or URLs) to other Office documents or HTML files

d. shows the beginning and ending balances and the amount of payment

3. In the accompanying figure, the hyperlink __________.

a. provides general, basic information about the rudimentary loan requirements

b. answers questions pertaining to the effect of 11 different interest rates

c. links (file path names or URLs) to other Office documents or HTML files

d. shows the beginning and ending balances and the amount of payment

4. To control the color and thickness of an outline and border, use the __________.

a. Patterns tab in the Format Cells dialog box

b. Fill Color button on the Formatting toolbar

c. Border tab in the Format Cells dialog box

d. Borders button on the Formatting toolbar

5. It is important that border characteristics be selected in this order: __________.

a. (1) choose the border type; (2) choose the border line style; and (3) choose the color

b. (1) choose the border line style; (2) choose the color; and (3) choose the border type

c. (1) choose the color; (2) choose the border type; and (3) choose the border line style

d. (1) choose the color; (2) choose the border line style; and (3) choose the border type

6. To use a name in a formula that is made up of two or more words, any space is replaced with a(n) __________.

a. asterisk ( * )

b. underscore character ( _ )

c. ampersand ( & )

d. number sign ( # )

7. Each of the following is true regarding the assignment of names to cells except __________.

a. names can be a minimum of one character to a maximum of 255 characters

b. names are relative references

c. names display in alphabetical order in the Name list

d. names are global to the workbook

8. Labels are different from names in all of the following ways except __________.

a. labels are not absolute

b. labels cannot be used on other worksheets in the workbook

c. labels display in the Name list

d. labels can be used without entering underscores in place of spaces

9. The general form of the PMT function is __________.

a. =PMT(rate, payment, loan amount)

b. =PMT(payment, loan amount, rate)

c. =PMT(loan amount, rate, payment)

d. =PMT(rate, loan amount, payment)

10. When entering the PMT function, to display the monthly payment as a positive number, a __________ can be entered before the loan amount.

a. greater than sign

b. plus sign

c. less than sign

d. negative sign

11. The FV function is a frequently used financial function that returns the future value of an investment based on __________.

a. periodic, constant payments, and a constant interest rate

b. sporadic, inconsistent payments, and a constant interest rate

c. periodic, varying payments, and a varying interest rate

d. sporadic, inconsistent payments, and a varying interest rate

12. When entering formulas from cells E4, E5, and E6 in a loan analysis section into cells C9, D9, and E9 in a data table, the best alternative is to __________ because (1) it is an easier method; and (2) if the formulas in the loan analysis section change, the formulas in the data table are updated automatically.

a. retype the formulas in cells C9, D9, and E9

b. copy cells E4, E5, and E6 to cells C9, D9, and E9, respectively

c. enter the formulas in cells C9, D9, and E9 using names instead of cell references

d. enter the formulas =e4 in cell C9, =e5 in cell D9, and =e6 in cell E9

13. The Table command on the __________ is used to define a range as a data table.

a. Insert menu

b. Format menu

c. Data menu

d. Edit menu

14. All of the following are important points about one-input data tables except __________.

a. the formulas being analyzed must include a cell reference to the input cell

b. there can be as many active data tables in a worksheet as desired

c. while only one formula can be analyzed, as many values can vary as desired

d. a data table can be deleted by selecting the table and pressing the delete key

15. Analysts often look for the row in the data table that agrees with the __________.

a. input cell names

b. input cell results

c. output cell names

d. output cell results

16. The __________ can be used to determine how much the borrower of a loan still owes at the end of each year.

a. PV function

b. FV function

c. PMT function

d. DDB function

17. The IF function =IF(G3 <= $E$3, PV($E$2 / 12, 12 * ($E$3 – G3), -$E$4), 0) assigns __________ to the cell if the logical test is false.

a. $E$2 / 12

b. 12 * ($E$3 – G3)

c. -$E$4

d. 0 (zero)

18. When a formula is entered in a cell, Excel assigns the cell the __________.

a. Currency style format

b. same format as the first cell reference in the formula

c. Comma style format

d. same format as the last cell reference in the formula

19. With Excel, hyperlinks easily can be created to __________.

a. other files on a personal computer

b. an intranet

c. the World Wide Web

d. all of the above

20. Print options available on the __________ in the Page Setup dialog box include print area, gridlines, black and white, draft quality, row and column headings, and page order.

a. Sheet sheet

b. Margins sheet

c. Page sheet

d. Header/Footer sheet

21. Cells should be protected only __________.

a. before the worksheet has been fully tested and displays incorrect results

b. before the worksheet has been fully tested and displays the correct results

c. after the worksheet has been fully tested and displays incorrect results

d. after the worksheet has been fully tested and displays the correct results

22. Protecting a worksheet is a two-step process: __________.

a. (1) select the cells to be left unprotected and change their cell protection settings to an unlocked status; (2) protect the entire worksheet

b. (1) select the cells to be left protected and change their cell protection settings to an unlocked status; (2) unprotect the entire worksheet

c. (1) protect the entire worksheet; (2) select the cells to be left unprotected and change their cell protection settings to an unlocked status

d. (1) unprotect the entire worksheet; (2) select the cells to be left protected and change their cell protection settings to an unlocked status

23. To protect more than one sheet, select each one before beginning the protection process or click __________ on the Protection submenu that displays when pointing to Protection on the Tools menu.

a. Protect Sheet

b. Allow Users to Edit Ranges

c. Protect Workbook

d. Protect and Share Workbook

24. The formula checker is invoked by clicking the __________ on the Tools menu.

a. Spelling command

b. Error Checking command

c. Scenarios command

d. Formula Checking command

25. A cell __________ does not violate any of Excel’s formula checking rules.

a. with a formula that is locked in an unprotected worksheet

b. containing a formula that does not match the pattern of the formulas around it

c. with numbers stored as text

d. containing a formula that does not use the expected syntax, arguments, or data types

True/False

	T
F
	1. Two of the least powerful aspects of Excel are its limited array of functions and its inability to organize answers to what-if questions.

	T
F
	2. A key feature of Excel is its capability to add hyperlinks to a worksheet.

	T
F
	3. Using a column as a separator between sections on a worksheet is a common technique used by spreadsheet specialists.

	T
F
	4. While usually cells are formatted after values are entered, Excel allows cells to be formatted before values are entered.

	T
F
	5. The Currency style format has an impact on text in a cell.

	T
F
	6. If a percent sign (%) is appended to 8.25 when it is entered into a cell, Excel automatically formats the cell in the Percent style with no decimal places.

	T
F
	7. Worksheets often have column titles at the top of each column and row titles to the left of each row that describe the data within the worksheet.

	T
F
	8. The Name command on the Insert menu can be used to define descriptive names that are not column titles or row titles to represent cells, ranges of cells, formulas, or constants.

	T
F
	9. Naming a cell that will be referenced in a formula makes the formula more difficult to read and remember.

	T
F
	10. Excel is case-sensitive with respect to names of cells.

	T
F
	11. If a formula is entered using Point mode and a cell that has a name is clicked, then Excel will insert the cell reference rather than the name of the cell.

	T
F
	12. A name assigned on one worksheet in a workbook can be used on other sheets in the same workbook to reference the associated cell or range of cells.

	T
F
	13. Spreadsheet specialists often assign names to a cell or range of cells so they can select them quickly.

	T
F
	14. It is necessary to enter commands to assign label names.

	T
F
	15. It is important to note that Excel recognizes labels in formulas even if label usage is not activated.

	T
F
	16. Because financial institutions calculate interest on a monthly basis, the rate value in a PMT function is annual rate * 12.

	T
F
	17. Excel considers the value returned by the PMT function to be a credit and, therefore, returns a positive number as the monthly payment.

	T
F
	18. In addition to the PMT function, Excel provides more than 50 additional financial functions to help solve the most complex finance problems.

	T
F
	19. Data tables are built in a used area of the worksheet.

	T
F
	20. With a one-input data table, the value in one cell varies and Excel then calculates the results of one or more formulas and fills the table with the results.

	T
F
	21. A two-input data table allows the values in two cells to vary, but it can be applied to only one formula.

	T
F
	22. The cell immediately to the left of the formulas in a one-input data table should include an input value.

	T
F
	23. The number of formulas placed at the top of a one-input data table depends on the application.

	T
F
	24. When entering formulas in a data table, cell references are preferred over cell names because if cell references are used, Excel will not assign a format to the cell.

	T
F
	25. To include additional formulas in a one-input data table, enter them in adjacent cells in the same row as the current formulas and then define the entire new range as a data table by using the Table command on the Data menu.

	T
F
	26. The table for an amortization schedule is limited to 15 years.

	T
F
	27. The PV function can determine an ending balance after the first year by using a term equal to the number of months the borrower still must make payments.

	T
F
	28. The IF function =IF(G3 <= $E$3, PV($E$2 / 12, 12 * ($E$3 – G3), -$E$4), 0) displays the value of the PV function or zero depending on whether the corresponding value in column G is less than or equal to the number in cell E3.

	T
F
	29. In a function, dollar signs within a cell reference indicate the cell reference is relative and, therefore, will change as the function is copied.

	T
F
	30. If cell H3 has a Currency style format and cell I3 has a Comma style format, when the formula =H3 – I3 is entered in cell J3, Excel assigns the Comma style format to cell J3.

	T
F
	31. The results of the IF function display using the format of the first cell reference in the function.

	T
F
	32. The Comma Style button on the Formatting toolbar uses the digit 0 to represent zero.

	T
F
	33. A destination file (or hyperlinked file) can be any Office document or HTML file (Web page).

	T
F
	34. Once a hyperlink is assigned to an element in a worksheet, the mouse pointer can be positioned on the element to display the hyperlink as a ScreenTip.
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